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About Client Access for UNIX OS 
StarQuest Client Access for UNIX OS ("Client Access for UNIX OS") allows you to connect your UNIX 
system to an IBM AS/400 system. This expands the capability of your UNIX system with any combination 
of the following: 

  Sharing information between systems  
  Transferring data between systems  
  Emulating a 5250 terminal  
  Submitting AS/400 system commands from your UNIX workstation 

Client Access for UNIX OS includes the following applications and features: 

  File Transfer 
  5250 Terminal Emulator 
  Remote Command  
  Client Access Shell (CASH) 
  Server Manager 
  APIs  

Standard IBM AS/400 Client Access APIs 

Special Client Access for UNIX OS APIs 

Installation 

Information about installing this product on your UNIX system is covered in files on the product CDROM. 
Consult with your System Administrator for details. Also see About Installing Client Access for UNIX 
OS. 

Accessing Applications 

You can access applications from the Main Menu or the command line. X Window users can click on the 
program icons in the COSE Application Manager. 

See Main Menu and Command Line Access. 

Transferring Files  

The File Transfer user interface is designed to let you quickly transfer files between your UNIX machine 
(client) and an AS/400 host (server). See About Transferring Files. 

5250 Emulator 

Provides IBM 5250 terminal emulation for convenient access to the AS/400 from your UNIX system. See 
About the 5250 Emulator for information. 

Remote Command 

Lets you run AS/400 commands on the AS/400 from your UNIX system. See Remote Command for 
information. 

Server Manager 

Lets you manage your connections to host servers. See About Setting Servers and Server Manager for 
more information. 
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Technical Information 

About APIs

Localization

Troubleshooting
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About Installing Client Access for UNIX OS 
The product and License Manager installation and deinstallation information are on the StarQuest Client 
Access for UNIX OS CDROM and can be accessed from Help Contents ('Install and Deinstall Instructions 
(Setup'). 

This Help file and a browser are installed with the product. The Help files are in HTML 1.1 and can be read 
with any HTML browser you specify with the Browser environment variable. 

Review the information in Running the Program, About Setting Servers, and Environment Variables for 
post-installation information before using the product. 

You can access the product applications from the Main Menu or the command line. X Window users can 
use the COSE desktop icons. See Main Menu and Command Line Access for more information. 

The Client Access for UNIX OS applications and features are: 

  Main Menu 
  Server Manager 
  File Transfer  
  5250 Emulator 
  Remote Command 
  Client Access Shell (CASH) 
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Before You Begin 
Before you begin using StarQuest Client Access for UNIX OS you should be familiar with the UNIX 
operating system. 

There are several sources of information about StarQuest Client Access for UNIX OS: 

  Online Help (used with a Browser) 
  UNIX man pages 
  Install and Deinstall Instructions 
  Reference guides 

Online Help describes the features and their functions. Help indicates what information is specific to X 
Window System** users and what is specific to character-oriented terminal users.  

Manual Pages provide technical descriptions of the product applications. 

Refer to your UNIX system documentation for information on navigating your system. Also see 
"Navigating for Character-oriented Terminals" in Running the Program for information. 

Install and Deinstall information can be accessed from the Help Contents Technical Information section, 
"Install and Deinstall Instructions (Setup)." 

You may want to refer to these IBM books for information about the AS/400: 

  National Language Support SC41-3101 

For information about AS/400 Systems at V3R1 or later CISC releases: 

  Publications Reference SC41-3003 provides information on all the books in 
the AS/400 library.  

For information about AS/400 Systems at V3R6 or later RISC releases: 

  Publications Reference SC41-4003 provides information on all the books in 
the AS/400 library.  

For API information, see About APIs and refer to the StarQuest Client Access for UNIX OS API and 
Technical Reference guide provided on the product CDROM. It can be read with the browser provided with 
the Client Access for UNIX OS product or any commercial browser that reads HTML. Or, contact 
StarQuest for information about a printed copy of the document. 

You are now ready to begin Running the Program. 
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Running the Program 
Information in this section: 

  Application Access 
  About Client Access Shell (CASH) 
  About COSE Icon Access 
  Setting Servers 
  Setting Environment Variables 
  How to Reset Environment Variables at Logon 
  Navigating for Character-oriented Terminals 

Application Access 
There are several ways to access Client Access for UNIX OS and its applications:  

Main Menu

Command Line Access

Client Access Shell (CASH)

COSE Icon (X Window only) 

About Client Access Shell (CASH) 

Client Access Shell (CASH) provides a command line interface to communicate with the AS/400. You can 
use the Client Access Shell to transfer files, set servers, and issue remote commands to the AS/400. 

About COSE Icon Access 

The Client Access for UNIX OS application group icon ('CA400') appears in the COSE Application 
Manager. The COSE Application Manager installation for Client Access for UNIX OS is described in the 
UNIX Install section of the Setup instructions on the product CDROM.  

How to run applications using the COSE Icons 

In the COSE Application Manager, double click on the CA400 application group icon ('CA400') to 
access the individual application icons.  

Double click on an application icon to open that application. 

Setting Servers 

See About Setting Servers for information about adding servers before you begin using Client Access 
UNIX for OS for the first time. Also see Server Manager. 

Setting Environment Variables 

The environment variables must be set correctly for the Client Access for UNIX OS programs to run 
successfully.  

See Configuration on the Client Access for UNIX OS Main Menu for a list of your current settings for the 
required environment variables. See Environment Variables for details about the required environment 
variable settings for the Client Access for UNIX OS programs.  
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How to Reset Environment Variables at Logon 

Follow the steps below to set your Client Access for UNIX OS environment variables so they are 
automatically set every time you logon or issue the indicated command. See Environment Variables for a 
list of required environment variable settings. Set the environment variables in the order shown there. 

C shell (csh) users: 

Step 1 
In your home directory (for example, /home/users/your_user_name), edit your .cshrc file and add all 
applicable environment variables for your system at the end of the file. Example: 

setenv CA400 CA400_directory_name [Example: /usr/lpp/ca400] 

setenv PATH ${PATH}:${CA400}/bin 

setenv TMPDIR system_temp_directory [Example: /tmp] 
setenv env_variable value 
... 
... 

Step 2 
Save the edited .cshrc file. 

Your Client Access for UNIX OS environment variables are now set and will be set every time you logon 
or issue this command: 

source ${HOME}/.cshrc 

Korn or Bourne shell (ksh, sh): 

Step 1 
In your home directory (for example, /home/users/your_user_name), edit your .profile file and add all of 
the environment variables for your system at the end of the file. For example: 

CA400=CA400_directory  
export CA400 

PATH=${PATH}:${CA400}/bin 
export PATH 

... 

... 

Step 2 
Save the edited .profile file. 

Your Client Access for UNIX OS environment variables are now set and will be set every time you logon 
or issue this command: 

. ${HOME}/.profile 
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Navigating for Character-oriented Terminals 
5250 Emulator Menu 

Menu Bar - Press ESC-m to see the Menu Bar and user interface. 

Application Navigation 

Use these keys for navigating Client Access for UNIX OS application menus: 

  Use Tab and Shift-Tab to move forward and backward to the functions 
  Press Return to select an item 
  Use the Arrow keys to move within functions or to scroll lists 

Browser Navigation 

The Client Access for UNIX OS browser functions are described in this section. 

Each Help topic is accessible through a hyperlink. The Help Contents lists all of the Help topics as 
hyperlinks ("Links"). When you display a particular topic, Links to related topics may be in the text. 

Use the Tab key to move between menu items and Help text. 

Selecting a Topic: 

  Up Arrow - move to nearest topic Link before cursor and highlight the Link 
  Down Arrow - move to nearest topic Link after the cursor and highlight the 

Link 
  Right Arrow - display the highlighted Link topic 

Moving within a Topic: 

  Ctrl f - scroll forward 
  Ctrl b - scroll backward 

Return to Previous Topic: 

  Left Arrow - Return to previous topic(s)  

Browser Menu: 

  File   

Shell - open a UNIX shell 

Exit - exit Help 

  View  

Refresh - refresh the Help screen 
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  Go  

Back - move to previous topic(s) 

Forward - move to next topic 

Page Up - move up the page of current topic 

Page Down - move down the page of current topic 

Before you use Client Access for UNIX OS, you may want to review How to Print and Manual Pages. 
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Running the Program 

Configuration 
You can the access the Configuration user interface from the Client Access for UNIX OS Main Menu. 
Click on Exit to return to the Main Menu. 

Configuration lists your current settings for the environment variables required for Client Access for UNIX 
OS. The environment variables must be set correctly for your system in order to successfully use the Client 
Access for UNIX OS applications. See Running the Program for a description of how to insure your 
environment variables are reset correctly each time you open Client Access for UNIX OS. See 
Environment Variables for information about the required settings. 

Environment Variables 
You must set the environment variables correctly in order to run Client Access for UNIX OS. From the 
Main Menu, select Configuration to see a list of your current environment variable settings. See Running 
the Program for a description of how to set your environment variables so they are reset correctly each time 
you open Client Access for UNIX OS.  

Set the environment variables listed below that apply to your system. Be sure to set the platform-specific 
and terminal-specific environment variables that apply to your system. All environment variables are case-
sensitive and must be set in the order shown.  

NOTE: All variables that apply to your system must be set except the optional SHELL variable.  

CA400   
CA400 specifies the path to a fully-installed and configured Client Access for UNIX OS software 
distribution.  
AIX Example:  

CA400=/usr/lpp/ca400  
export CA400 

Solaris and HP-UX Example:  

CA400=/opt/ca400  
export CA400 

PATH  
Specifies the path for the Client Access for UNIX OS applications.  

If PATH already has a value set:  

PATH=${PATH}:${CA400}/bin  
export PATH 

If PATH does not have a value set:  

PATH=${CA400}/bin  
export PATH 
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BROWSER  
Specify the name of the browser you want to use to access on-line Help and Setup. NOTE: Client Access 
for UNIX OS supplies a local browser ("cabrowser" for character-oriented terminals, "xcabrowser" for X 
Window). However, you can specify any browser that reads .HTML files.  

Local browser example (xcabrowser for X Window and cabrowser for Character-oriented terminals):  

BROWSER=browsername   
export BROWSER 

Commercial browser example:  

BROWSER=browsername (example: BROWSER=netscape)  
export BROWSER 

LANG   
LANG determines the language for intrinsic messages for Client Access for UNIX OS. If LANG is not set 
or is set to the empty string, the default "C" is used (see lang (5)). See Localization for information about 
locale and language settings available for your UNIX platform. The locales supported for each platform are 
in ${CA400}/etc/lang.tab.  

LANG=C  
export LANG 

MANPATH  
Sets the path for man pages.  

If MANPATH already has a value set:  

MANPATH=${MANPATH}:${CA400}/man  
export MANPATH 

If MANPATH does not have a value set:  

MANPATH=${CA400}/man  
export MANPATH 

STARLM  
Sets the path to a fully-installed StarQuest License Management package which is required before Client 
Access for UNIX OS can run.  
Example:  

STARLM=/opt/local/starlm  
export STARLM 

TMPDIR   
Temporary files are normally created in directory /tmp. You may designate an alternate temporary directory 
by assigning a pathname to TMPDIR.  
Example:  

TMPDIR=/var/tmp  
export TMPDIR 
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Character-oriented Terminals Only 

TERM   
Identifies the type of terminal in use (see environ(5) and term(5)).  

TERM=vt100  
export TERM 

Optional - Character-oriented terminals only  

SHELL   
SHELL defines the shell interpreter invoked when "Shell" is selected from the File menu of an application. 
If SHELL is not set or is set to the empty string, the default interpreter /bin/sh is used (see sh(1)).  
Example:  

SHELL=/bin/sh [/bin/csh for C-Shell]  
export SHELL 

SHELL allows you to work in a UNIX shell while in a Client Access for UNIX OS application. Type 'Exit' 
to leave the shell and return to the application.  

X Window Only  

DISPLAY  
Identifies the X Window display.  

DISPLAY=systemname:0.0  
export DISPLAY 

AIX Platform Only  

LIBPATH  
Specifies the library path for AIX.  

If LIBPATH already has a value set:  

LIBPATH=${LIBPATH}:${CA400}/lib  
export LIBPATH 

If LIBPATH does not have a value set:  

LIBPATH=${CA400}/lib  
export LIBPATH 

HP-UX Platform Only  

SHLIB_PATH  
Specifies the library path for HP-UX.  

If SHLIB_PATH already has a value set:  

SHLIB_PATH=${SHLIB_PATH}:${CA400}/lib  
export SHLIB_PATH 

If SHLIB_PATH does not have a value set:  

SHLIB_PATH=${CA400}/lib  
export SHLIB_PATH 
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Solaris Platform Only  

LD_LIBRARY_PATH  

Specifies the library path for Solaris.  

If LD_LIBRARY_PATH already has a value set:  

LD_LIBRARY_PATH=${LD_LIBRARY_PATH}:${CA400}/lib:/usr/dt/lib  
export LD_LIBRARY_PATH 

If LD_LIBRARY_PATH does not have a value set:  

LD_LIBRARY_PATH=${CA400}/lib:/usr/dt/lib  
export LD_LIBRARY_PATH 

NOTE: The X Window libraries Xm, Xt, and X11 may not be included here. If the application cannot find 
these libraries, add the library path to LD_LIBRARY_PATH.  

Command Line Access 
You can use the Main Menu to access Client Access for UNIX OS applications or use the command line.  

NOTE for new users: Before opening any Client Access for UNIX OS applications, it is important that you 
review Running the Program for information about initial requirements. 

Main Menu and Application Directory 

The Main Menu and other applications are stored in directory ${CA400}/bin. 

Browser 

Open the browser and Help file supplied with Client Access for UNIX OS: 

X Window: 

xcabrowser ${CA400}/nls/${LANG}/index.html 

Character-oriented terminals: 

cabrowser ${CA400}/nls/${LANG}/index.html 

Main Menu 

Open the Main Menu user interface: 

X Window: 

xcamenu 

Character-oriented terminals: 

camenu 

Client Access Shell 

Open the Client Access Shell (CASH) user interface (command line interface is used to communicate with 
the AS/400): 

cash 
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Server Manager 

Open the Server Manager user interface: 

X Window: 

serverman 

Character-oriented terminals: 

casm 

File Transfer  

Open File Transfer User Interface:  

X Window: 

xcaftp 

Character-oriented terminals: 

caftp 

NOTE: You can specify a Profile file name after the application name to open File Transfer with the 
preferences set. 

5250 Terminal Emulator  

Open the 5250 Emulator User Interface:  

X Window: 

xca5250 

Character-oriented terminals: 

ca5250 

Remote Command 

Open the Remote Command user interface:  

X Window: 

xcarc 

Character-oriented terminals: 

carc 

NOTE: You can specify a Profile file name after the application name to open Remote Command with the 
preferences set. 

How to Print 
Client Access for UNIX OS does not provide a separate printing utility.  
Use the existing AS/400 and UNIX standard TCP/IP print utilities  
(lpr and lpd). Refer to the AS/400 and UNIX manuals for information.  

Or, refer to the IBM AS/400 Service and Support web page "Remote  
Printing with TCP/IP": http://www.as400.ibm.com/service/400tcp/lpr.htm 
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Manual Pages 
There is a UNIX man page for each application in Client Access for UNIX OS. You can access a man page 
by typing "man application_name" on the command line. The application names are listed in Command 
Line Access. Also see Environment Variables for additional man page references. 

A complete list of the Client Access for UNIX OS man pages is in ${CA400}/man/cat1. A list of the 
StarQuest License Management man pages is in $STARLM/man/man1. 
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Main Menu 
Type xcamenu (X Window users) or camenu (character-oriented terminal users) at the UNIX prompt to 
display the Client Access for UNIX OS Main Menu. X Window users can choose to access the Main Menu 
by clicking on the COSE icon. 

Use the Main Menu to select the Client Access for UNIX OS application you want to use. Select 
'Configuration' from the Main Menu to see your current settings for the required Environment Variables. 

X Window Main Menu: 

  5250 Emulator 
  File Transfer  
  Remote Command  
  Server Manager 
  Configuration 
  Help 
  Exit 

Click on 'Exit' to exit from Client Access for UNIX OS and return to the UNIX prompt. 

Character-oriented Terminal Main Menu: 

1) 5250 Emulator 

2) File Transfer 

3) Remote Command 

4) Configuration 

5) Help 

Enter the number of your selection or enter "." to exit from Client Access for UNIX OS and return to the 
UNIX prompt. 

For more information see 

About the 5250 Emulator

About Transferring Files

Remote Command

About Setting Servers

Configuration
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About Transferring Files 
File Transfer is used to copy files to and from the AS/400. There are several ways to access File Transfer: 

  Main Menu - select File Transfer 
  Enter xcaftp (X Window) or caftp (character-oriented terminals) from the 

command line 
  Click on the File Transfer COSE icon (X Window) 
  5250 Emulator - select File: Transfer... (X Window) 

User Interface 

The File Transfer user interface lets you select files to transfer to the AS/400 or AS/400 files to transfer to 
your UNIX system. You can also select AS/400 servers, select binary or ASCII text format for the file 
transfer, and specify options for text conversion. 

Profile File Stores File Transfer Preferences 

File Transfer reads its initial preference settings from your default Profile file (${HOME}/.ca400/xcaftprc 
for X Window and ${HOME}/.ca400/caftprc for character-oriented terminals) after preferences are initially 
saved in the file ('File: Save' in the application). You can create new Profile files by saving session 
preferences with 'File: Save As...'. You can restart a previously saved session using the preferences saved in 
a Profile file by selecting 'File: Open' or with this command: 

xcaftp profile_filename (X Window) 

or 

caftp profile_filename (Character-oriented terminals) 

See File Transfer Menu Commands for more information about Profile Files and descriptions of all menu 
functions. 

See File Transfer User Interface for information about File Transfer features. 

See File Transfer Technical Information for important technical information about file transfers. 

See also: File Transfer Toolbar and File Transfer List Boxes

23 





 

Transferring Files 
File Transfer is used to copy files to and from the AS/400. There are several ways to access File Transfer: 

  Main Menu - select File Transfer 
  Enter xcaftp (X Window) or caftp (character-oriented terminals) from the 

command line 
  Click on the File Transfer COSE icon (X Window) 
  5250 Emulator - select File: Transfer... (X Window) 

User Interface 

The File Transfer user interface lets you select files to transfer to the AS/400 or AS/400 files to transfer to 
your UNIX system. You can also select AS/400 servers, select binary or ASCII text format for the file 
transfer, and specify options for text conversion. 

Profile File Stores File Transfer Preferences 

File Transfer reads its initial preference settings from your default Profile file (${HOME}/.ca400/xcaftprc 
for X Window and ${HOME}/.ca400/caftprc for character-oriented terminals) after preferences are initially 
saved in the file ('File: Save' in the application). You can create new Profile files by saving session 
preferences with 'File: Save As...'. You can restart a previously saved session using the preferences saved in 
a Profile file by selecting 'File: Open' or with this command: 

xcaftp profile_filename (X Window) 

or 

caftp profile_filename (Character-oriented terminals) 

See File Transfer Menu Commands for more information about Profile Files and descriptions of all menu 
functions. 

See File Transfer User Interface for information about File Transfer features. 

See File Transfer Technical Information for important technical information about file transfers. 

See also: File Transfer Toolbar and File Transfer List Boxes

File Transfer User Interface 
Client Access for UNIX OS File Transfer lets you transfer files between your UNIX system and the 
AS/400. You select the file to copy to an existing directory or one you create. The file is copied in binary or 
text format. You select the server and text conversion options.  

You can access File Transfer from the Main Menu, the command line xcaftp for X Window and caftp for 
character-oriented terminals, the File Transfer COSE icon (X Window), or from the 5250 Emulator select 
'File: Transfer...' (X Window). 

File Transfer features: 

Main Menu 

  File - Default, Open..., Save, Save As..., Exit  

Shell (character-oriented terminals only) 
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  View -   

X-Window: By Name, By Time, Reversed, Hidden Files 

Character-oriented terminal: Filter, Refresh, By Name, By Time, Reversed, Hidden Files 

  Server - Server..., [List of servers] 
  Options -   

X-Window: End of Line Characters, Text Conversion, Tab Character Conversion 

Character-oriented terminal: Prompting, Binary transfer, Text transfer, Strip newlines, Strip 
carriage returns, Expand tabs 

  Help - Help Browser, About... 

For detailed menu information, see File Transfer Menu Commands

Tool Bar (X Window only] 

The Tool Bar is a set of buttons representing tools that let you navigate the list boxes and do the following:  

  Up - Move up one directory from selected directory. 
  Change Dir - Enter different directory (and path) in dialog box. 
  Create Dir - Enter directory name (and path) in the dialog box.  
  Filter - Select the directories and files to view in the list box. For example, 

enter "*.doc" to see only .doc files.  
After you make your selection, the filter label next to File: indicates the filter 
applied to the current directory and files. The default is all files (*) in a 
directory. 

  Info - (UNIX side only) Display a message box with file information (similar 
to the UNIX command ls -l). 

  Rename - (UNIX side only) Rename a file or directory. 
  Delete - Delete the selected file or directory (a directory must be empty). 

For detailed information, see File Transfer Toolbar. 

Copy  
Copy transfers the selected file to the selected target destination. 

Binary or Text 

You can specify binary or text for the format of the file being transferred. 

Prompting 

If selected, the system checks if a file the same name exists on the target system and, if so, prompts you 
with a message. If Prompting is not selected, the target file is given the same name as the source file. 
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Status Line 

The Status Line describes the function of the feature at the cursor location and the program activity status. 

See also  

About Transferring Files

File Transfer Menu Commands

File Transfer Toolbar

File Transfer List Boxes

File Transfer Technical Information

File Transfer Menu Commands 
About the Profile File: 

Profile files store the File Transfer preferences listed below and are used when you select 'Default' or 
'Open...' in the File menu. File Transfer default Profile files are xcaftprc (X Window) and caftprc 
(character-oriented terminal). Profile files contain the following File Transfer variables: 

  System focus (UNIX or AS/400) 
  Server name (NOTE: If a server is specified in your caftprc or xcaftprc default 

Profile file, it is the default server. Otherwise, the default server set in CASH is 
used.) 

  Current directories for UNIX and AS/400 
  Sort order (same as Filter) for UNIX and AS/400 
  Transfer mode (binary or text) 

Main Menu 

File - Default, Open..., Save, Save As..., Shell, Exit  

Use the File features to manage different session profiles for File Transfer.  

Default - resets the current file transfer session to the default session profile. The Profile filename is 
displayed on the right side of the Title Bar. 

Open... - opens the "Open Profile File" window. Enter a Profile filename and path in the 'Selection' 
field and select "OK". Or, use the list boxes to select a directory and file. Use 'Filter' to narrow the 
selection: enter the directory and file selection you want and select 'Filter'.  

When you have selected the directory and the filename you want is in the 'Selection' field, select 
"OK".  

The Profile filename is displayed on the right side of the Title Bar and the Profile preferences are 
used for the current session. 

Save - saves the session parameters to the current session Profile filename. 

Save As... - opens the "Save Profile File" window and saves the current session preferences to a 
Profile filename you specify. Enter a Profile filename and path in the 'Selection' field and select 
"OK". Or, use the list boxes to select a directory and file. Use 'Filter' to check for existing directories 
and files: enter the directory and file selection you want and select 'Filter'.  

When you are done and the directory and filename you want is in the 'Selection' field, select "OK".  

The "Save As" Profile filename is displayed on the right side of the Title Bar.  
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Shell - (character-oriented terminals only) opens a UNIX shell. Type "exit" to return to File Transfer. 
This lets you work in a UNIX shell without exiting the File Transfer application.  

NOTE: The SHELL environment variable determines the shell that opens. 

Exit - exits File Transfer.  

View - View the files in the selected directory by By Name, By Time, in Reverse order, or show Hidden 
files. 

Server - Server..., [List of Servers]  

Server... (X Window only) opens the Server Manager dialog box for managing servers.  

List of Servers: servers known to Client Access. The current server is indicated and you can select a 
different server from the list. A message appears if you select a server that is not currently available.  

NOTE: for more information about servers, see About Setting Servers. 

Options - Select options for text conversion. 

X Window only: 

End of Line Characters [select one] 

-Convert to Newline: UNIX  
-Convert to Carriage Return: Macintosh 
-Convert to Carriage Return and Newline: DOS, OS/2, Windows 
-No conversion [default] 

Text Conversion [select one] 

-Convert based on current locale [default] 
-Convert to locale... 
-Convert to codeset... 
-No conversion 

Tab Character Conversion [select one] 

-Expand to spaces, tabstops... 
-No conversion [default] 

Character-oriented terminals only: 

Prompting - If selected, the system checks if a file the same name exists on the target system and, if 
so, prompts you with a message. If Prompting is not selected, the target file is given the same name 
as the source file. 

Binary transfer 

Text transfer 

Strip newlines 

Strip carriage returns 

Expand tabs 

Help - Help Browser, About... 

Help Browser gives you context-sensitive help. 

Also see 

File Transfer Toolbar 
File Transfer List Boxes 
File Transfer User Interface 
File Transfer Technical Information
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File Transfer Toolbar (X Window only) 
The File Transfer Toolbar is a set of buttons that let you easily navigate the file transfer list boxes. All 
toolbar buttons affect only the listbox for the selected (highlighted) system (local or remote). These buttons 
are available to X Window users only.  

Toolbar  

  Up - Move up one directory level. 
  Change Dir - Change directory (using relative or absolute path names). 
  Create Dir - Create a new directory (and path).  
  Filter - Select the files to view in list box. For example, enter *.doc to list 

.doc files only. The default without a filter selected is a listing of all files in a 
directory (*). 

  Info - (UNIX side only) Display a message box with file information (like the 
UNIX ls -l command). 

  Rename - (UNIX side only) Rename a selected file or directory.  
  Delete - Delete a selected file or directory (a directory must be empty). 

Also see: 

File Transfer Menu Commands

File Transfer List Boxes

File Transfer User Interface

File Transfer Technical Information

File Transfer List Boxes 
The list of your local UNIX files is displayed on the left of the File Transfer user interface and the AS/400 
(remote) list box is on the right. See File Transfer Menu Commands, File Transfer Toolbar, and File 
Transfer Technical Information for information about transferring files and selecting transfer options. 

NOTE: Be sure to specify both local and remote directories and files before you use transfer any file. 

  User and System - This field is highlighted when the listbox is selected. The 
field identifies the user name, system name, and the system (local or 
remote). 

  Current directory path - This field shows the directory path and current 
location.   

X Window: You can change the directory path by selecting this field and then selecting Change Dir 
on the Tool Bar and entering a new path. 

Character-oriented terminal: Tab to the directory command line, enter a directory path, press 
Return. 

  Directories - This listbox shows all of the directories below the current 
directory. Use the scroll bars to see more directories.   

X Window: Click on a directory to select it. Double click on a directory to change to that directory. 

Character-oriented terminal: Tab to list box, use Arrow keys to scroll to a directory name, press 
Return to select. 
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  Files - This listbox shows all of the files in the selected directory.   

X Window: Use the scroll bars to see more files. Click on the file you want to copy to the AS/400. 

Character-oriented terminal: Tab to listbox, use Arrow keys to scroll to a file name, press Return 
to select. 

  Copy - Select to copy the selected file to the target system.   

X Window: Click on the Copy button. 

Character-oriented terminal: Tab to Copy at bottom of screen and press Return. 

ATTENTION: Make sure the target list box is set to the directory you want.  
The source file is copied with the same name as the target unless Prompting is selected.  

  Binary, Text - You can transfer a file in either binary format or text format.   

X Window: Click on Binary or Text. 

Character-oriented terminal: Select Binary and Text transfer in the Options Menu. 

  Prompting - If selected, the system checks if a file by the same name is on 
the target system. If so, you are prompted to overwrite or rename the file. If 
Prompting is not checked, the target file is given the same name as the 
source file.   

X Window: Click on Prompting. 

Character-oriented terminal: Select Prompting in the Options Menu to rename a file being copied. 

See also  

File Transfer User Interface

File Transfer Menu Commands

File Transfer Toolbar

File Transfer Technical Information

File Transfer Technical Information 
This section contains important technical details about StarQuest Client Access for UNIX OS file transfers 
that you should review. Refer to the IBM AS/400 reference manuals for definitions of technical terms and 
detailed information. File Transfer utilizes two file systems: 

  QSYS File System 
  QDLS and QOPENSYS File Systems 

Each system is described below. 

QSYS File System 

File Transfer supports the upload and download of the following types of files: Source Physical Files (SPF) 
and Database (DB) Files. These files are converted from ASCII to EBCDIC when uploaded and from 
EBCDIC to ASCII when downloaded. 
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Client Access for UNIX uses Database APIs for uploading and downloading files in the QSYS file system.  

Source Physical files on the AS/400 

  Typically contain 3 fields per record: Line [sequence number] number, Date, 
and Data.  

  The files can have multiple members. Any of these members may be accessed 
for file transfer.  

Database files on the AS/400 

  Can contain single or multiple fields. Database files can contain multiple 
members unless the file is an SQL table. SQL Tables contain only one 
member. 

  File uploads to multiple-field DB file members of the same member name are 
not supported by File Transfer. 

Download of Source Physical Files from the Host 

Source Physical file members are downloaded to the client as a single data field (line numbers and dates are 
stripped). Records are delimited by a newline. 

Download of Database Files from the Host 

Database file members are downloaded to the client with field delimiters (space) and single quotes 
encapsulating the field data. Records are delimited by a newline. 

Upload Files to the Host in the QSYS file system  

A file uploaded to QSYS is written as a single alphanumeric field. 

Records are delimited by a newline. A newline on the UNIX system will cause a new record to be created. 
If the [length of a line is greater than the record length of the target file, the text is wrapped. 

If any kind of file is uploaded to a directory ('library') in QSYS where a file of the same name does not 
exist, a new Source Physical file and member of the same name is created by default.  

If a file is uploaded to QSYS and a file of the same name exists, File Transfer checks to see if it is a 
Database file or a Source Physical file. 

UPLOADING SOURCE PHYSICAL FILES IN QSYS 

Sequence numbers and date fields get updated by the AS/400 for uploaded Source Physical files. 

Uploading a SPF to a library where a file of the same name does not exist: 

  A new SPF and member of the same name is created. 

Uploading a SPF when the same file name exists in the specified library: 

  An '..overwrite?' prompt appears within the file transfer applications.  

If 'OK' is selected, the first file member is cleared. A new file member of the same name as the file 
is then inserted. The new data is inserted as a single field in the member. Other members within 
that file are not changed. 
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UPLOADING DATABASE FILES IN QSYS 

If uploading to a Database file that is an SQL table, the default member (usually of the same name) is the 
only member where data can be inserted. 

When uploading to a Database file with the same file name, file transfer checks the default member for 
more than one field. 

  If the Database file member contains one field, an '..overwrite?' prompt 
appears within the file transfer applications.  

If 'OK' is selected, the member gets 'cleared', and the new data is inserted as a single field.  

  If the Database file member contains more than one field, the upload function 
is not supported by file transfer and displays an error message. 

If a file is a single column SQL table and the source file name is the same as the target table name, the table 
is overwritten. Otherwise the appropriate error message is returned: "Request not supported" or 
"CPFXXXX Unable to add member...". 

QDLS and QOPENSYS File Systems 

Client Access for UNIX uses bytestream (bit for bit) for uploading to and downloading from these file 
systems.  

Types of files transferred using QDLS and QOPENSYS: binary and text files.  

NOTE: Text file transfer uses iconv converters on the client for uploading and downloading files. See your 
System Administrator for information about iconv converters or see the UNIX man page 'iconv'. 

Download binary files from the Host  

The file is transferred bit for bit to the client in the same format as it exists on the host. 

Downloading a binary file to a directory containing a file with the same name displays an '..overwrite?' 
prompt in the File Transfer application. Selecting 'OK' overwrites the file. 

Download text files from the Host 

The iconv converters on the client convert the EBCDIC text from the host to text corresponding to the 
ASCII code page selected for the client. (This text conversion is determined by the lang setting as described 
in Localization.) 

Downloading a text file to a directory containing a file with the same name displays an '..overwrite?' 
prompt in the File Transfer application. Selecting 'OK' overwrites the file. 

Upload binary files to the Host 

The file is transferred bit for bit to the host in the same format as it exists on the client. 

Uploading a binary file to a directory containing a file with the same name displays an '..overwrite?' prompt 
in the File Transfer application. Selecting 'ok' overwrites the file. 
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Upload text files to the Host 

The iconv converters on the client convert the ASCII text from the client to the EBCDIC code page selected 
for the host. (This text conversion is determined by the lang setting as described in Localization.) 

Uploading a text file to a directory containing a file with the same name displays an '..overwrite?' prompt in 
the File Transfer application. Selecting 'OK' overwrites the file. 

See also  

About Transferring Files

File Transfer User Interface

File Transfer Menu Commands

File Transfer Toolbar

File Transfer List Boxes

33 





 

Remote Command 
Remote Command lets you run AS/400 commands from your UNIX system. It provides an alternative to 
the 5250 emulator. There are several ways to access Remote Command: 

  Main Menu - select Remote Command 
  Command line - enter xcarc (X Window) or carc (character-oriented 

terminals) 
  Click on the Remote Command COSE icon (X Window) 
  5250 Emulator - select File: Remote Command... (X Window) 

Remote Command features: 

  Select Server from menu 
  Run single commands 
  Run a file of commands in series (batch file) 
  Tool bar button functions (X Window) 
  Online Help 
  Profile file with preference settings 

About the Profile File: Profile files store the Remote Command preferences listed below. A Profile file is 
used when you select 'Default' or 'Open...' in the File menu. The Remote Command default Profile files are 
xcarcrc (X Window) and carcrc (character-oriented terminal). Profile files contain the following Remote 
Command variables: 

  Server name (NOTE: If a server is specified in your carcrc or xcarcrc default 
Profile file, it is the default server. Otherwise, the default server set in CASH is 
used.) 

  Remote command(s) previously saved in the command field  

OR 

Batch file name previously saved in the command field. 

Main Menu 

File - Default, Open..., Save, Save As..., Exit 

Shell (character-oriented terminals only) 

Server - Server... (X Window only), [List of servers] 

Help - Help Browser, About... 

For details about the Remote Command Main Menu functions, see descriptions in the File Transfer Menu 
Commands section. File Transfer menu descriptions also apply to Remote Command. 

Command Field 

Type AS/400 commands (for example, CRTLIB TEMP) or a UNIX filename which has commands in series 
(batch file). 

Text Box 

Displays the command (underlined) and the return message, if any. 
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Run 

Executes the command in the Command Field and displays the command and results in the Text Box. 

Syntax 

Checks the syntax and validity of the command in the Command Field. 

Clear 

Clears the Command Field and text box. 
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Client Access Shell (CASH) 
Client Access Shell (CASH) provides a command line interface to communicate with the AS/400. You can 
use the Client Access Shell to transfer files, set servers, and issue remote commands to the AS/400. 

Enter cash at the UNIX prompt in the ${CA400}/bin directory to use the CASH feature. Enter quit to exit 
from CASH. 

CASH Commands 

NOTE: Words in italics indicate names you supply and "remote" refers to the AS/400. 

cd - Prints the remote working directory name. 

cd pathname - Changes the remote working directory. 

currentserver - Displays information about the current server. 

defaultserver - Displays information about the default server. 

deletefile filename - Removes a remote file. If you are in the QSYS system, you must enter the fully-
qualified pathname of the file. Example: To delete myfile, enter this command: deletefile 
/QSYS.LIB/test.lib/myfile.file 

getdbfile libraryname membername [localfilename] - Transfers a database file from the remote AS/400 
to your UNIX machine. NOTE: getdbfile is used only for downloading database files in the QSYS file 
system on the AS/400. Example: To get "/QSYS.LIB/test.lib/myfile.file/myfile.mbr", enter the command, 
library name (test) and the member name (myfile): getdbfile test myfile localfilename 

get remotefile localfile - Copies a remote file to a local file. Example: get/QDLS/testlib/test /tmp/test 

ls pattern - Lists contents of a remote directory. Use pattern to match the remote file or directory name. For 
example, *ab finds matches for any remote file or directory with a name ending in "ab". 

mkdir directoryname - Creates a remote directory. 

pingserver file|central|netprt|signon||rmtcmd|dtaq|database|Port Mapper host_server_name - Verifies 
that a server at the host is available. If the host_server_name is not provided, the default is used. The 
default server is the server last connected. Example: pingserver 449 myhost.ibm.com 
NOTE: pingserver is useful for verifying the status of the AS/400 servers. See Troubleshooting for more 
information. 

put localfile remotefile - Copies a local file to a remote file. Example: put /tmp/test /QDLS/testlib/test 
WARNING: If a file of the same name exists, it will be overwritten without warning. 

For a file upload to the QSYS filesystem, the target member name must be specified. Example: put 
/tmp/test /QSYS.lib/testlib.lib/test.file/test.mbr 

WARNING: If a file or member of the same name exists, it will be overwritten without warning. 

quit - Exits the CASH shell. 

removeserver servername - Removes the specified server. 

rmdir directoryname - Removes a remote directory (if empty). 

runcmd command - Issues remote command to the current AS/400 port. 

serverlist - Prints information about all known servers. 

setserver hostname userid password - Connects to a new host server. 

transfermode [binary|text] - Sets the file transfer mode. 
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Using the 5250 Emulator 
The Client Access for UNIX OS 5250 Emulator lets you logon to a networked AS/400 from your UNIX 
system and communicate remotely with the AS/400 host. 5250 Emulator user interface provides these 
features: 

X Window 

  Key mapping 
  Host language setting 
  Menu access to File Transfer and Remote Command 
  Online Help 
  Session settings 
  Server management and selection  
  Copy and paste 
  Printing 

Character-oriented terminals 

  Key mapping (by editing the ca5250_keymap file) 
  Online Help 
  Server selection 
  Printing 
  Session settings (by editing the ca5250rc file) 

See the sections below for detailed information about the 5250 terminal emulator. 

5250 Emulator User Interface

5250 Emulator Menu Commands

5250 Emulator Session Settings

5250 Emulator Copying and Pasting

5250 Emulator Keyboard Mapping

5250 Emulator User Interface 
The 5250 Terminal Emulator provides a user interface for remote terminal access to the AS/400. 

5250 Emulator User Interface 

X Window:  

Select 5250 from the Main Menu, by clicking on the COSE icon, or by entering xca5250 at the 
command line to open the 5250 emulator and access the AS/400 Sign On screen. 

Character-oriented terminals:  

Select 5250 from the Main Menu or enter ca5250 at the UNIX command line to open the 5250 
emulator and access the AS/400 Sign On screen.  

Press ESC-m to see the Menu Bar and use the arrow keys to navigate. 
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Menu Bar (X Window only) 

  File - New, Print Screen, Printer Setup, File Transfer... , Remote Command... , 
Exit 

  Edit - Copy, Paste, Select All 
  Server - Server..., [List of servers] 
  Session - Connect, Disconnect, Settings... 
  Keypad - [5250 Function list (Tear Off) ] 
  Help - Help Browser, About... 

Menu Bar (character-oriented terminals only) 

  File - Print Screen, Exit 
  Server - [List of servers] 
  Session - Connect, Disconnect 
  Keypad - [5250 Function list] 
  Help - Help Browser, About... 

Keypad 

Select Keypad for standard 5250 key selection. See 5250 Emulator Keyboard Mapping for default mapping 
tables and information about changing the key mapping. 

Tear Off Keypad [X Window]: 

The standard 5250 functions can be selected from the Keypad menu. Click on the dotted line at the 
top of the list and it turns into a "Tear Off Keypad" window. Click and hold the title bar to drag the 
list to any part of your screen for display. Click on the Close box in the left corner of the Tear Off title 
bar to close the list. 

5250 Status Line 

Status Indicators 

Highlighted menu items are described in the status line. When no menu item is highlighted, the status line 
shows the system status (for example, "Connected"). 

The following status indicators are only true when red (X Window) or displayed (Character-oriented 
terminals): 

SA (System Available) 

The AS/400 is operating and available to your system. 

MW (Message Waiting) 

The AS/400 has one or more messages for you. 

KS (Keyboard Shift) 

The keyboard is in shifted mode. 

IM (Insert Mode) 

Characters inserted into an existing field will not type over the existing data. 

II (Input Inhibited) 

Keyboard input is not being accepted by the AS/400 because the system is processing your request.  
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KB (Keystroke Buffering) 

Keystrokes are being saved in a temporary buffer (storage space) because keyboard input is not being 
accepted by the AS/400 (as indicated by the II indicator). After the II indicator goes off, the 
keystrokes are processed. To clear the keystroke buffering, press the RESET key. 

KNJ (Double Byte Field) 

(Displayed for Double Byte only) The cursor is currently in a field that accepts DBCS character 
input. 

LISO (Lower ISO Shift) 

(Displayed for Double Byte only) This indicator shows the state of the LISO Shift function. LISO 
Shift allows the display of lower case Latin characters when using certain DBCS languages. 

Host Name 

The AS/400 host name used by UNIX to connect to the AS/400 is displayed at the right end of the status 
line. 

See also: 

5250 Emulator Menu Commands

5250 Emulator Copying and Pasting

About the 5250 Emulator

5250 Emulator Session Settings

5250 Emulator Menu Commands 
Character-oriented terminal users press ESC-m to see the Menu and use the arrow keys to navigate. 

File Menu 

  Create a new session, print the contents of the screen, run File Transfer or Remote Command, or 
exit from the 5250 emulator.  

  New [X Window only]  

Start a new session with the default settings. 

  Print Screen  

Print the screen contents. 

  Printer Setup [X Window only]  

Opens the Print Setup window where you enter a command used for local printing on your UNIX 
system (normally "lp"). 

  File Transfer... [X Window only]  

Opens the File Transfer application. 

  Remote Command... [X Window only]  

Opens the Remote Command application. 

41 



Client Access for UNIX User's Guide 

  Exit  

Exit from the 5250 Emulator.  

  
 

 
Edit Menu [X Window only] 

  The Edit menu is used to select and move text. 

  Copy   

Copy the selected text to the clipboard.  

  Paste   

Copies text from the clipboard and pastes it at the selected location. 

See 5250 Emulator Copying and Pasting for details. 

  Select All   

Selects all text on the screen.  

 

 
Server Menu 

  Use the Server Menu to select an AS/400 server. 

  Server... [X Window only]  

Choose Server... to open the Server Manager dialog box. 

  List of Servers  

Select a server from a list of AS/400 servers known to Client Access. A message appears if you 
select a server that is not currently available. The current server is indicated. 

 

 
Session Menu 

  Use the Session Menu to connect and disconnect from your current AS/400 server and change 
default 5250 settings. 

  Connect   

Connects to the host AS/400 and displays the AS/400 Sign On screen. 
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  Disconnect   

Disconnects from the AS/400. The AS/400 screen clears. 
You can now exit the 5250 emulator or connect to a different server. 

  Settings... [X Window]  

NOTE: Character-oriented terminal users can change feature settings by editing the ca5250rc file. 

Opens the Session Settings dialog box and allows you to change these settings:  

o Host Language 
o Display Type 
o Cursor Type 
o Key Mapping 

See 5250 Emulator Session Settings for detailed information. 

 

 
Keypad 

The standard 5250 functions can be selected from the Keypad menu. X Window only: Click on the 
dotted line at the top of the Keypad. The Keypad turns into a "Tear Off Keypad" window. Click and 
hold the title bar to drag the list to any part of your screen for display. Click on the Close box in the 
left corner of the Tear Off Keypad title bar to close the list. 

See 5250 Emulator Keyboard Mapping for more information. 

 

 
Help 

  Help Browser  

Opens the browser and shows Help topic for the selected function. 

  About...  

Displays Client Access for UNIX OS information. 

See also: 

About the 5250 Emulator
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5250 Emulator Copying and Pasting (X Window only) 
The 5250 Emulator allows you to make a copy of displayed text so that you can use that information in 
other applications. After copying information to the Clipboard, you can change to a different application 
and paste the information into that application. You can also copy information from other applications into 
the 5250 screen. The pasted information is entered as a series of keystrokes. 

To copy and paste displayed information in the 5250 terminal emulator window: 

1. Select (highlight) the information you want to copy or choose Select All from the Edit menu. 

2. Choose Copy from the Edit menu. The selection is copied to the Clipboard. 

3. Change to the application where you want to paste the contents of the Clipboard. 

4. Select the insertion point with the cursor. 

5. Choose Paste from the Edit menu. The text is inserted at the cursor location. 

To copy information from an application and paste it into the 5250 emulator window: 

1. Copy the selected information to the Clipboard by using the application's standard copy command. 

2. Change to an active 5250 emulator session or start a 5250 emulator session. 

3. Check to see that the session is in a state in which keystrokes can be received. 

4. Choose Paste from the Edit menu. The copied information is entered as a series of keystrokes at 
the cursor location. 

See also: 

About the 5250 Emulator

5250 Emulator Session Settings 
All 5250 Emulator features are configured with default settings based on your language and operating 
environment. X Window users select Settings from the Session menu to customize the 5250 Emulator. For 
character-oriented terminals, use the ca5250rc file to customize the 5250 emulator features.  

The following 5250 Emulator features can be customized: 

  Host Language 
  Display Type 
  Cursor Type 
  Key Mapping 

Host Language 

Use Host Language to indicate the language to use on your AS/400. The language, by default, is set 
depending on the setting of your LANG variable. Available languages are shown in the Host Language 
drop-down list. 

Display Type 

Use Display Type to select the display you want:  

1. Select 'Display Type' from the Feature drop down. 
2. Click the checkbox by the display you want. 
3. Click on OK. 
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Cursor Type 

Use Cursor Type to customize the cursor:  

1. Select 'Cursor Type' from the Feature drop down. 
2. Click on Block or Underline. 
3. Select or deselect Blinking. 
4. Click on OK. 

Key Mapping 

The key mapping dialog shows two scrollable list boxes. One contains a list of all mappable 5250 
Functions. The other contains Local Key Mappings. To display a key mapping for a particular 5250 
function, scroll through the 5250 Function list to the desired function. Click on the desired function and the 
local key mappings appear in the Local Key Mapping list box. See 5250 Emulator Keyboard Mapping for 
tables of the X Window and character-oriented terminal default key mappings. 

Add a new key mapping 

1. Select the desired 5250 function in the 5250 Function list box. 
2. Click the 'Add Mapping' button. 
3. Press the key sequence you want for the 5250 function, or enter a key and 

select Shift, Control, or Alt from the Modifier Keys section. 
4. Click 'Save' to save the new mapping. 

Modify an existing mapping 

1. Select the desired 5250 function in the 5250 Function list box. 
2. Select the local key mapping you want to change in the Local Key Mapping 

list box. 
3. Click the 'Modify Key Mapping' button. 
4. Press the key sequence you want for the 5250 function or enter a key and 

select Shift, Control, or Alt from the Modifier Keys section. 
5. Click 'Save' to save the new mapping. 

Delete an existing mapping 

1. Select the desired 5250 function in the 5250 Function list box. 
2. Select the local key mapping to delete in the Local Key Mapping list box. 
3. Click the 'Delete Key Mapping' button. 

See 5250 Emulator Keyboard Mapping for tables of the default key mappings and technical information 
about editing the default mappings. 
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5250 Emulator Key Mapping 
Your 5250 Emulator has default key mappings for X Window and character-oriented terminals. These key 
mappings are shown below. Or, you can change the key mappings to suit your needs. 

If you use X Window, you may use Session Settings: Key Mapping to customize the key mapping. See 
5250 Emulator Session Settings for more information. 

Key Mapping File Information 

The 5250 functions to local key mappings are maintained in two files: xca5250_keymap for the X Window 
version and ca5250_keymap for the character-oriented terminal version. Each file uses symbolic names to 
represent 5250 functions and local key strokes required to generate the 5250 function. Although each file 
can be edited, you may want to change the X Window keymap file using Session Settings in the application 
menu. 

Note: man pages xca5250(1) and ca5250(1) contain information and default key mapping. 

Both xca5250_keymap and ca5250_keymap are created in your directory ${CA400}/.ca400 the first time 
the application is run. Prototypes for these files containing the default key mappings can be found in 
${CA400}/etc. These files should be copied to your ${CA400}/.ca400 directory before editing. See the 
comment sections in each of these files for the proper syntax. 
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Default Key Mapping for X Window  
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Default Key Mapping for Character-oriented Terminals 
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Setting Servers 
Setting servers is a post-installation task and updates your .signon file. When you open File Transfer, 
Remote Command, or the 5250 Emulator, the server in the .signon file is the current server. Before you 
begin using Client Access UNIX for OS for the first time, it is a good idea set a server.  

WARNING 

DO NOT DIRECTLY EDIT THE .signon FILE. The .signon file can be updated only by server 
changes (Add, Modify, Delete servers) made through the Server Manager, File Transfer, 5250 
Emulator, and Remote Command applications, as listed below. 

Required AS/400 Servers 

All required AS/400 servers must be connected and available in order to successfully run Client 
Access for UNIX OS. Use the Cash Access Shell (CASH) command 'pingserver' to verify that the 
eight necessary AS/400 servers are connected and available. (See the "Client Access Shell" topic for 
command syntax and "Troubleshooting" for details.) 

Access to Set Servers (X Window) 

  Main Menu: Server Manager 
  Command line: enter serverman 
  File Transfer: Select 'Server: Server...' from Main Menu to run Server Manager 
  Remote Command: Select 'Server: Server...' from Main Menu to run Server 

Manager 
  5250 Emulator: Select 'Server: Server...' from Main Menu to run Server 

Manager 
  Client Access Shell (CASH) setserver command 
  COSE icon for Server Manager 

Access to Set Servers (Character-oriented terminals)  

  Client Access Shell (CASH) setserver command 

Instructions for Setting Servers  

Follow the instructions below to set servers for your system.  

NOTE: When you add, modify, or delete a server, your .signon file is updated. When you open File 
Transfer, Remote Command, or the 5250 Emulator, the server in the .signon file is the current server.  

X Window users can also see Server Manager for information about managing servers.  

Set Servers: X Window  

To add a server using the Server Manager user interface:  

1. Click the 'Add' button. 

2. In 'Add Server', enter the server name, valid user ID, and password information. 

3. Click 'OK'. 

This updates your .signon file and the server is ready to connect.  
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To modify a server using the Server Manager user interface:  

1. Click the 'Modify' button. 

2. In 'Modify Server', enter a new valid user ID and password information. 

3. Click 'OK'. 

This updates your .signon file and the server is ready to connect.  

To delete a server using the Server Manager user interface:  

1. Select a server from the Server list. 

2. Click the 'Delete' button. 

This updates your .signon file and the server is removed from your .signon file and does not appear in the 
server list on applications.  

Set Server: Character-oriented Terminal  
To add a server:  

1. Enter 'casm' at the UNIX command line. 

2. Tab to 'Add' at the bottom of the screen and press Return. 

3. In the Server window, enter the Host Name, User ID, and Password. 

4. Tab to 'OK' and press Return. 

This updates your .signon file and the server is ready to connect.  

To modify a server:  

1. Enter 'casm' at the UNIX command line. 

2. Tab to 'Modify' at the bottom of the screen and press Return. 

3. In the Server window, select server name and enter new User ID, and Password. 

4. Tab to 'OK' and press Return. 

This updates your .signon file and the server is ready to connect.  

To delete a server:  

1. Enter 'casm' at the UNIX command line. 

2. In the Server window, select server name. 

3. Tab to 'Delete' at the bottom of the screen and press Return. A Confirm window appears. 

4. Tab to 'Yes' and press Return. 

This updates your .signon file. The server is removed from your .signon file and does not appear in the 
server list on applications.  

Character-oriented terminal users follow the information below using the Client Access Shell (CASH) 
application.  
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To set a server using CASH:  

1. Enter cash at the UNIX prompt. 

2. Enter the command: 

setserver hostname userid password  

 

  

3. Enter quit to exit CASH. 

This updates your .signon file and the server is ready to connect.  

See Client Access Shell (CASH) for other commands that can help you manage servers.  

Server Manager (X Window) 
Server Manager provides a graphic interface for setting servers. There are several ways to access Server 
Manager:  

  Main Menu: Server Manager 
  Command line: enter serverman  
  File Transfer: Select 'Server: Server...' from the menu bar to run Server 

Manager 
  Remote Command: Select 'Server: Server...' from the menu bar to run Server 

Manager 
  5250 Emulator: Select 'Server: Server...' from the menu bar to run Server 

Manager  
  COSE icon for Server Manager 

Server Manager displays the available servers and shows the user ID for each. You can add a server, delete 
a server, or modify server information using Server Manager. 

New users with X Window should follow the procedures below to add servers before using the Client 
Access for UNIX OS applications. Character-oriented terminal users see About Setting Servers. 

To set a server using the Server Manager user interface: 

1. Click the 'add' button. 

2. In 'Add Server', enter the server name, valid user ID, and password information. 

3. Click 'OK'. 

This updates your .signon file. When you add, modify, or delete a server, your .signon file is updated. When 
you open File Transfer, Remote Command, or the 5250 Emulator, the server in the .signon file is the current 
server. See About Setting Servers for information about adding, modifying and deleting servers. 

See Client Access Shell (CASH) for other commands that can help you manage servers. 

Also see About APIs. 
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About APIs 
You can use the Client Access for UNIX OS API and Technical Reference (provided on the product 
CDROM) for developing your own applications for Client Access for UNIX OS. 

NOTE: The Client Access for UNIX OS API and Technical Reference provided on the product 
CDROM can be read with this browser or a commercial browser. Or, contact StarQuest for 
information about a printed copy of the document. 

Knowledge of the setup of your compiler and execution environment on the UNIX platform is 
recommended before you create applications that use the Client Access APIs. Information on linking 
libraries and compiling code is supplied below for specific UNIX platforms. 

API Implementation 

The APIs for Client Access for UNIX OS are implemented as C functions that you can link into your own 
applications. This guide describes how to use the various APIs in the program.  

NOTES:  

1. You must use the library files and C header include files provided with Client Access for UNIX 
OS. 

2. The APIs can be used with C programming language; it is not necessary to use C++. 

In order to use Client Access for UNIX OS APIs, you must link your code to several libraries and then use 
the specified compilers. The information below describes the libraries, linkers, and compilers needed for 
AIX, Solaris** (SunOS**), and HP-UX** platforms. 

NOTE FOR HP-UX: 

A patch PHCO_7177 for users of the NIS (Network Information Service**) is normally installed 
during the standard Client Access for UNIX OS installation procedure. The patch and detailed 
information is in http://support.mayfield.hp.com. 

Link to Libraries: 
You must make the following links to your code: 

Application library  

Example (Remote Command):  

libca400rc.a for AIX  
or 
libca400rc.sl for HP-UX 
or 
libca400rc.so for Solaris 

CA400 library 

libca400.a for AIX 
or 
libca400.sl for HP-UX 
or 
libca400.so for Solaris  
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Compiling APIs: Platform-Specific Information  
AIX 

Compiler: xlC or xlc (No special flag is needed.)  

Solaris 

Compiler: CC or cc (No special flag is needed.)  

HP-UX 

Compiler: CC or cc (No special flag is needed.)  

Security: 

Database: 

cwbDB_StartServer returns CWB_SECURITY_ERROR if no security information is found in .signon file 
(see Security in Troubleshooting for details). A user interface is not implemented in Client Access for 
UNIX OS. 

Data Queue: 

cwbDQ_Open, cwbDQ_Create, and cwbDQ_Delete return CWB_SECURITY_ERROR if no security 
information is found in .signon file (see "Security" in Troubleshooting for details). No user interface is 
implemented in Client Access for UNIX OS. 

Remote Command: 

cwbRC_StartSys returns CWB_SECURITY_ERROR if no security information is found in the .signon file 
(see "Security" in Troubleshooting for details). No user interface is implemented in Client Access for UNIX 
OS. 

Serviceability (Debug and Log Trace): 

All messages and trace information are forwarded to syslogd instead of a file. syslogd is a UNIX system 
daemon. To view or save messages sent to syslogd, refer to your UNIX manual. 

Debug 

A debug configuration file, $CA400/etc/conf/debug.cf, is used to turn debug ON and OFF during run time. 
(To modify debug.cf, the user must have the authority to access the $CA400 installation directory.) Debug 
is OFF by default.  

Turn the message log on set: 

SV\DEBUG MESSAGE_LOG,ON 

Turn trace on set:  

SV\DEBUG TRACE,ON 

Turn entry and exit trace on set:  

SV\DEBUG TRACE,ON  
and  

SV\DEBUG ENTRY_EXIT,ON 

Log Data Stream 

Debug trace is also implemented for logging the data stream. To turn it on, set CO\DEBUG=TRACE,ON 
and assign a full-path filename to capture the log. By default, the capture file is set to /tmp/ca400_co.log. 
This debug trace is implemented in Client Access for UNIX OS only. There is no API to control the trace. 
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Program Creation 

You can use the Client Access for UNIX OS API and Technical Reference as a guide for developing your 
own applications. You need to create your own make files, and compile and link scripts. You may use the 
standard imake facility in UNIX and UNIX compiler supplied by your UNIX vendor. Knowledge of the 
setup of your compiler and execution environment on the UNIX platform is recommended before you start 
creating applications that use the Client Access APIs. 

Header Files 

The header files for the Client Access for UNIX OS product are located in the $CA400/include directory for 
the product. The path for include files must be in your compiler directives. 

NOTE: You must use the header files provided with the Client Access for UNIX OS product. The header 
files for other platforms have the same names as the UNIX header files, but are different. 

Header files included with the Client Access for UNIX OS product: 

Header file Usage 

 

cwb.h Common definitions 

cwbco.h Configuration APIs 

cwbdb.h Database APIs 

cwbdq.h Data queue APIs 

cwbdt.h  Data transformation APIs 

cwbsv.h Service APIs 

cwbsy.h Security APIs 

cwbobj.h Object APIs 

cwbrc.h  Remote Command APIs 

cwbport.h UNIX specific APIs 

Library Files  

The library files for the Client Access for UNIX OS product are UNIX shared libraries for both AIX and 
Solaris and static libraries for HP-UX. They are located in the $CA400/lib directory. Make sure that your 
make files include a reference to these library files before you create your applications. 

If the Client Access for UNIX OS library files are relocated after linking with your application, the 
environment variable that sets the library path for your platform must be set to include the new location. 
See Environment Variables for more information. 

Library files are included with the Client Access for UNIX OS product: 
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AIX 4.1.4 Libraries  

These are shared libraries created by xlC. 

File  Usage  

libca400.a  Core functions  

libca400db.a  Database functions  

libca400dq.a  Data queue functions  

libca400rc.a  Remote Command functions  

libca400obj.a  AS/400 object functions  

Solaris 2.5 Libraries  

File  Usage  

libca400.so  Core functions  

libca400db.so  Database functions  

libca400dq.so  Data queue functions  

libca400rc.so  Remote Command functions  

libca400obj.so  AS/400 object functions  

HP-UX 10.10 Libraries  

File  Usage  

libca400.sl   Core functions  

libca400db.sl  Database functions  

libca400dq.sl  Data queue functions  

libca400rc.sl  Remote Command functions  

libca400obj.sl  AS/400 object functions  
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Troubleshooting 
Client Access for UNIX OS provides several levels of help: 

  Online Help 
  Online messages 
  man pages 
  Setup Instructions (on product CDROM) 
  Client support 

If you have a question that cannot be answered by using online Help, messages, or man pages, contact your 
System Administrator for help. Your System Administrator is responsible for entering the user, security, 
server, licensing, and other information that allows you to use the StarQuest Client Access for UNIX OS 
product to communicate commands and transfer files between your local UNIX system and the remote 
AS/400. 

Required AS/Servers 

All required AS/400 servers must be connected and available in order to successfully run Client Access for 
UNIX OS.  

Use the Cash Access Shell (CASH) command 'pingserver' to verify that the eight necessary AS/400 servers 
are connected and available. The servers are: central, database, dataquery, file, netprt, remote command, 
signon, and Port Mapper. (See the Client Access Shell (CASH) for command syntax.) The table shows the 
Socket numbers or names to use with the pingserver command (example: pingserver netprt 449 
myhost.ibm.com). 

Socket # Server Name 

   

449 Port Mapper 

8470 central 

8471 database 

8472 dtaq 

8473 file 

8474 netprt 

8475 rmtcmd 

8476 signon 
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Solaris Security Error  

If a Solaris system user receives a security error, check with your System Administrator to make sure that 
the post-installation script was run as described in Installation. 

StarQuest License Manager 

The StarQuest License Manager must be running before StarQuest Client Access for UNIX OS can run. 
Check with your System Administrator if the License Manager should require restarting.  
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Localization 
AS/400 LOCALIZATION 

Refer to the IBM publication National Language Support SC41-3101 for a list of supported CCSIDs. 
CCSID is an AS/400 language term indicating the AS/400 code set which corresponds to a UNIX locale 
(LANG). 

UNIX LOCALIZATION 

This section describes the use of locale and the LANG environment variable. The platform-specific locale 
settings for the AIX 4.1.4, HP-UX 10.10, and Solaris 2.5 (SunOS 5.x) are listed in the Setup instructions on 
the product CDROM. Ask your System Administrator for details. 

The LANG environment variable you set for Client Access for UNIX OS determines the locale (language) 
of the program messages and screens you view on your UNIX system. For information about setting the 
LANG environment variable, see Environment Variables. 

The locales supported for each platform are listed in ${CA400}/etc/lang.tab. Enter a value from the Locale 
column to set the $LANG environment variable.  
Example:  

LANG=C 
export LANG 

NOTE: If the environment variable LANG is unset or is null, it defaults to LANG=C. 

About Locale Code Sets and iconv 
Locale defines the natural language running on a UNIX system. It is usually set as an environment variable 
(LANG). If the environment variable LANG is unset or is null, it defaults to LANG=C. 

CCSID is an AS/400 language term indicating the AS/400 code set which corresponds to a UNIX locale 
(LANG). Code sets for locale and CCSID are needed for string conversion between a UNIX system and an 
AS/400. The conversion is done using UNIX iconv which is described in a UNIX man page. The tables 
lang.cs and ccsid.cs can be used to look up the code set for the UNIX locale and AS/400 CCSID. 

The tables for each UNIX platform (AIX, Solaris, and HP-UX) are different and can be located 
in${CA400}/etc/conf .  

When sending data stream to the remote AS/400, Client Access for UNIX OS looks up the code set of its 
locale from lang.cs, then looks up the code set of the CCSID of the remote system from ccsid.cs. It then 
converts the text strings in the data stream from local code set to remote code set.  

When receiving data stream from the remote AS/400, Client Access for UNIX OS converts the text strings 
in the data stream from the remote code set to the local code set.  

Identifying Code Sets 

You can verify that your UNIX system has language conversion capability by checking the iconv resource. 
Check ${CA400}/etc/conf for the lang.cs and ccsid.cs code set tables. 

UNIX System Code Set: Find the local code set by looking into lang.cs for the matching locale. 

AS/400 Code Set: Find the AS/400 code set by looking into ccsid.cs with the host CCSID. 

For example, the code set of locale "C" is ISO8859-1 and CCSID 037 is IBM-037 for AIX. After obtaining 
the code sets, you can look up the iconv resource to find conversion information. 
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How to Look up Conversion Information 

AIX 

Look into the directories /usr/lib/nls/loc/iconv or /usr/lib/nls/loc/iconvTable to find the from-codeset_to-
codeset table. To convert from locale "C" to 037, you need ISO8859-1_IBM-037. You can also find the 
reverse conversion: IBM-037_ISO8859-1. 

Solaris  

Look into the /usr/lib/iconv directory to find the from-codeset%to-codeset table. 

HP-UX  

Look into the file /usr/lib/nls/iconv/config.iconv. The top portion of the file contains aliases, the second 
portion contains conversion entries. Locate entries with this command: 

from-codeset to-codeset table-name/- method-name/default ... 
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